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Notice to Users 
 

The E-swipe user documentation has been written by 
Escan Technologies Corp.  No part of this publication 
may be reproduced or distributed in any form or by any 
means without the prior written permission of Escan 
Technologies Corp.  It is permitted to make copies of the 
E-swipe diskettes to be used solely for backup, in case 
of destruction of the original. 
 
We welcome your suggestions and comments regarding 
improvements to E-swipe or this manual.  Changes will 
be incorporated in the new editions of this manual and in 
new versions of E-swipe.  Escan Technologies Corp. 
reserves the right to make improvements or changes to 
this product at any time without notice. 
 
While every reasonable precaution has been taken in 
the preparation of this manual and software, Escan 
Technologies Corp. assumes no responsibility or liability 
of any kind for errors or omissions, or for the 
consequences of such errors.  E-swipe is provided “as 
is” without warranty of any kind.  The entire risk as to the 
quality and performance of E-swipe is to you. 
 
This documentation was last updated for Version 2.0 of 
E-swipe. 
 
 
 

Serial Number                         
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License Agreement 
 
This license agreement is your proof of license.  Please treat it as valuable 
property. 
 
This is an agreement between you (either individual or entity), the end user, and 
Escan Technologies Corp.  If you do not agree to the terms of this agreement, 
promptly return the disk package and accompanying items (including written 
materials and binders or other containers) to the place you obtained them for a 
full refund. 
 
1.  GRANT OF LICENSE.  This License Agreement permits you to use one copy 
of the specified version of the E-swipe software product identified above 
("SOFTWARE") on any single computer, provided the SOFTWARE is in use only 
on one computer at any time.  If you have multiple Licenses for the SOFTWARE, 
then at any time you may have as many copies of the SOFTWARE in use as you 
have Licenses.  The SOFTWARE is "in use" on computer when it is loaded into 
the temporary memory (i.e. RAM) or installed into the permanent memory (e.g. 
hard disk, CD-ROM, or other storage device) of that computer, except that a 
copy installed on a network server for the sole purpose of distribution to other 
computers is not "in use".  If the anticipated number of users of the SOFTWARE 
will exceed the number of applicable Licenses, then you must have a reasonable 
mechanism or process in place to assure that the number of persons using the 
SOFTWARE concurrently does not exceed the number of Licenses.  If the 
SOFTWARE is permanently installed on the hard disk or other storage device of 
a computer (other than a network server) and one person uses that computer 
more than 80% of the time it is in use, then that person may also use the 
SOFTWARE on the portable or home computer. 
 
2.  COPYRIGHT.  The SOFTWARE is owned by Escan Technologies Corp. or its 
suppliers and is protected by United States copyright laws and International 
treaty provisions.  Therefore, you must treat the SOFTWARE like any other 
copyrighted material (e.g. book or musical recording) except that you may either 
(a) make one copy of the SOFTWARE solely for backup or archival purposes, or 
(b) transfer the SOFTWARE to a single hard disk provided you keep the original 
solely for backup or archival purposes.  You may not copy the written materials 
accompanying the SOFTWARE. 
 
3.  OTHER RESTRICTIONS.  This E-swipe License Agreement is your proof of 
license to exercise the rights granted herein and must be retained by you.  You 
may not rent or lease the SOFTWARE, but you may transfer your rights under 
this E-swipe License Agreement on a permanent basis provided you transfer 
this License Agreement, the SOFTWARE, and all accompanying written 
materials and retain no copies, and the recipient agrees to the terms of this 
Agreement.  You may not reverse engineering, decompile, or disassemble the 
SOFTWARE.  Any transfer of the SOFTWARE must include the most recent 
update and all prior versions.  
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4. DUAL MEDIA SOFTWARE.  If the SOFTWARE package contains both 3.5-
inch disks and CD-ROM, then you must use only the media appropriate for your 
single designated computer or network server.  You must not use the other 
media on another computer or computer networks, or loan, rent, lease, or 
transfer them to another user except as part of a transfer or other use as 
expressly permitted by this E-swipe License Agreement. 
 
LIMITED WARRANTY 
 
LIMITED WARRANTY.  Escan Technologies Corp. warrants that (a) the 
SOFTWARE will perform substantially in accordance with the accompanying 
written materials for a period of thirty (30) days from the date of receipt; and (b) 
any hardware accompanying the SOFTWARE will be free from defects in 
materials and workmanship under normal use and service for a period of one (1) 
year from the date of receipt.  Any implied warranties on the SOFTWARE and 
hardware are limited too thirty (30) days and one (1) year, respectively.  Some 
states do not allow limitations on duration of an implied warranty, so the above 
limitation may not apply to you. 
 
CUSTOMER REMEDIES.  Escan Technologies Corp.'s entire liability and your 
exclusive remedy shall be, at Escan Technologies Corp.'s option, either (a) return 
of the price paid or (b) repair or replacement of the SOFTWARE or hardware that 
does not meet Escan Technologies Corp.'s Limited Warranty and that is returned 
to Escan Technologies Corp. with a copy of your receipt.  This limited warranty is 
void if failure of the SOFTWARE or hardware had resulted from accident, abuse, 
or misapplication.  Any replacement SOFTWARE will be warranted for the 
remainder of the original warranty period or thirty (30) days, whichever is longer. 
Neither these remedies nor any product support services offered by Escan 
Technologies Corp. are available for this U.S.A. version product outside of the 
United States of America. 
 
NO OTHER WARRANTIES. Escan Technologies Corp. Disclaims all other 
warranties, either express or implied, including but not limited to implied 
warranties of merchantability and fitness for a particular purpose, with respect to 
the SOFTWARE, the accompanying written materials, and any accompanying 
hardware.  This limited warranty gives you specific legal rights.  You may have 
others, which may vary from state to state. 
 
NO LIABILITY FOR CONSEQUENTIAL DAMAGES.  In no event shall Escan 
Technologies Corp. or its suppliers be liable for any damages whatsoever 
(including, without limitation, damages for loss of business profits, business 
interruption, loss of business information, or other pecuniary loss) arising out of 
the use of or inability to use this Escan Technologies Corp. product, even if 
Escan Technologies Corp. has been advised of the possibility of such damages. 
Because some states do not allow the exclusion or limitation of liability for 
consequential damages, the above limitation may not apply to you. 
 
U.S. GOVERNMENT RESTRICTED RIGHTS 
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This SOFTWARE and documentation are provided with RESTRICTED RIGHTS.  
Use, duplication, or disclosure by the Government is subject to restrictions as set 
forth in subparagraph (c)(1)(ii) of the Rights in Technical Data and Computer 
Software clause at DFARS 252.227-7013 or subparagraphs (c)(1) and (2) of the 
Commercial Computer Software--Restricted Rights at 48 CFR 52-227-19, as 
applicable.   
 
This Agreement is governed by the laws of the State of California. 
 
COPYRIGHT 
 
Information in this document is subject to change without notice and does not 
represent a commitment on the part of Escan Technologies Corp.  The software 
described in this document is subject to the license agreement that is included 
with E-swipe, in whole or in part, in print, or in any other storage and retrieval 
system is prohibited.  No part of this publication may be reproduced, transmitted, 
transcribed, stored in a retrieval system, or translated into any language in any 
form by any means for any purpose other the purchaser's personal use without 
express written permission of Escan Technologies Corp. 
 
Copyright 1997 Escan Technologies Corp.  All rights reserved. 
 
Printed in the United States of America. 
 
This manual was produced using Microsoft Word for Windows. 
 
January 1999 (first printing) 
May 1999 (second printing) 
 
TRADEMARKS 
 
Exeba and the Exeba logo are registered trademarks of Escan Technologies 
Corporation. 
 
Microsoft and Windows are registered trademarks of Microsoft Corporation. 
 
Visual Basic is registered trademark of Microsoft Corporation. 
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CHAPTER 1 - Introducing E-
swipe 

 
E-swipe is the ultimate Windows serial communication 
software for the IBC smart readers.  E-swipe provides all the 
features you need to communicate with the reader easily 
and efficiently. 

 

E-swipe Features 
 

Briefly, E-swipe allows you to: 
 
ü Configure the communication port and 
communication settings to the settings that best suit the 
hardware you are using. 
 
ü Define the poll and delay settings such as time-outs, 
and poll delay. 
 
ü Define the protocol parameters such as turning the 
protocol on and off and defining the range of addresses 
to be polled. 
 
ü Create the schedules and employee files to 
download to the reader and view the data files uploaded 
from the reader using the built-in text editor. 
 
ü Download a schedules file and an employee file to 
the reader and view the reader’s response instantly. 
 
ü Upload the access control list (employee and 
schedules data) stored in the reader and save the data 
to a file if required. 
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ü Poll the reader to get the clock in and out data.  If 
the readers are networked, you can poll a single address 
or a range of addresses. 
 
ü Add the computer’s date and time when polling a J 
reader. 
 
ü Program the reader by sending the appropriate 
commands.  If the readers are networked, these 
commands can be sent to any address you enter.  The 
software will automatically add the command prefixes 
and terminating characters.  The response that comes 
back from the reader can be viewed in the response text 
box. 
 
ü Set the barcode options for every symbology that 
the reader supports.  These options include: enabling 
and disabling the symbology, setting the length of the 
barcode read, and specifying the barcode prefix. 
 
ü Set the magstripe options for track 1, 2 and 
multitrack readers.  These options include: enabling and 
disabling the track, specifying the prefix and delimiter 
characters, setting the magstripe length, etc… 
 
ü Set the relay options, speaker options and LEDs’ 
options to your preferences. 
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Using this Guide 
 

Organization of the guide 
 
Chapter 2 – explains in details the process of installing 
the software. 
 
Chapter 3 – provides specific information that you will 
use to configure E-swipe. 
 
Chapter 4 – provides detailed information on the 
communication port. 
 
Chapter 5 – if you have never used a text editor before, 
you should read this chapter to become familiar with the 
procedures used in manipulating a file. 
 
Chapter 6 – explains what a log file is and how to save 
data to it. 
 
Chapter 7 - if you have purchased a SA/STA reader, pay 
close attention to chapter 7.  This chapter illustrates how 
to download and upload the access control list. 
 
Chapter 8 – each section of this chapter describes the 
polling process of the transactional data from a certain 
type of reader.  You should read the section addressing 
the polling process of the type of reader you purchased. 
 
Chapter 9 – explains how to change and program the 
reader to the options required. 
 
Appendix I – describes the warning and error messages 
of E-swipe. 
 
Appendix II – explains how to get technical support and 
help on E-swipe. 
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CHAPTER 2 – Installing E-swipe 
 
The installation program allows you to install Exeba E-swipe 
from either a CD or floppy disks.  But, before you install it, 
you should verify that your computer meets certain 
requirements. 

 
 

System Requirements 
 
 

E-swipe has the following system requirements: 
 
q An IBM PC or compatible computer. 
 
q Microsoft Windows 95/98, or NT. 
 
q An 80486 or higher processor. 
 
q A minimum of 8 MB of RAM. 
 
q Approximately 10 MB of available disk space. 

 
 

Installing E-swipe 
 

 
1. Start Microsoft Windows. 

 
2. Close other applications 

 
3. Insert the E-swipe CD-ROM into your CD-ROM 
drive. 

 
4. Choose Run from the Start menu. 
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5. When the Run dialog box appears, type x:\setup 
(substitute the letter of your CD-ROM for x) and press 
Enter. 

 
6. Follow the on-screen instructions. 
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CHAPTER 3 – Customizing E-swipe 
 

 

E-swipe Main Screen 
 
When you start E-swipe, the main window will appear.  
From this window, you can access all of the application’s 
features.   
 

Main Menu 
 
There are six main menus:  
 

 
 

Setup – contains menu commands to customize the 
communication parameters used in the software. 
 
Terminal Data – contains menu commands to view and 
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save the data sent and received to and from the reader. 
 
Download – contains menu commands to download data 
files to the reader. 
 
Upload – contains menu commands to poll transactional 
data and upload the access control list from the different 
readers. 
 
Reader Commands – contains menu commands to 
program the reader. 
 
Help – contains menu commands to access the on-line 
help. 
 

 
Button Bar 
 
The button bar, which is located under the main menu, 
contains buttons that you can use to easily access some 
of the frequently used commands of E-swipe. 
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Status Bar 
 
The status bar displays messages on the communication 
status and the current settings in E-swipe.  It is divided 
into 5 panels.  These panels are: 
 
 

 
 
Status – displays the communication messages. 
 
Port – displays the number of the port used in 
communication. 
 
Settings –displays the settings of the port set up in the 
software. 
 
Protocol – displays the setting of the protocol as it is set 
up in E-swipe. 
 
Connect Time – displays the duration the port has been 
opened. 
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Set up E-swipe Options 

 
Before you start communicating with the reader you 
need to change the default settings in the software to the 
settings that best suit your hardware. The Setup menu 
provides commands for setting up options for the 
application. Whereas, the Reader Commands menu 
provides commands for setting up the reader. 
 
In order for the software to communicate properly with 
the reader, both the reader and the software should 
have the same settings. It is very imperative that when 
you change the setting on one,  to change them on the 
other.  
 
Commands available under the Setup menu are as 
follows: Port Parameters  (described in the next 
chapter), Poll/Delay Parameters , Protocol 
Parameters. 
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Poll/Delay Parameters 
 

The Poll/Delay Parameters command can be accessed 
from the Setup menu. The settings of the poll and delay 
parameters affect the commands that send and receive 
data to and from the reader.  You may need to try 
different settings until you find the  correct configuration 
for your hardware.  
 

 
 
 
These settings are: 

 

Delay  
 

Used by the polling commands only (polling STA, SA, 
DC and J reader). The delay is the number of 
milliseconds (0000-9999) the polling function should wait 
between polls.  The default is 100 millisecond. 
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Time Out 
 
The number of milliseconds (0000-9999) the software 
should wait, after sending a command, for a response 
from the reader before timing out.  The default is 100 
millisecond. 
 

Machine Speed 
 
The amount of time E-swipe should wait after sending a 
command and before receiving data from the reader. 
You can select any number from 1 to 50. The number 
you select is represented as a multiple of 10th of a 
millisecond. So if you select 1, the wait time will be 10 
millisecond.  The larger the number, the slower the data 
will be sent and received.  However, a small value may 
result in receiving fragmented data. 
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Protocol Parameters 
 
The reader can communicate with the software in 
protocol (network) or non protocol mode. The protocol 
command under the Setup menu allows you to specify 
the mode that the software will be using when 
communicating with the reader. 
 
To access this command, select Setup ⇒ Protocol 
Parameters. 
 
 

 
 
 

 To turn off the protocol on the reader, refer to the 
following topics: Set Reader Options, and Send 
Command. 
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How to turn the protocol off? 

 
1. First, turn the protocol off on the reader by using one 
of the commands mentioned above. 

 
2. Select the Protocol tab on this window if it not 
already selected. 

 
3. Select the Off radio button. 

 

4. Click on the Save button . 
 
 

How to turn the protocol on? 
 

1. If the readers are not set to protocol, then while 
the protocol is turned off in E-swipe, turn on the 
protocol on all of the readers. 

 
2. Select the Protocol tab on this window if it is not 
already selected. 

 
3. Select the On radio button to turn on the protocol 
in the software. 

 
4. Then select the default address from the Default 
Unit Address list. This address can be between 000 
and 126 and will be used as a default address when 
downloading, uploading or programming the reader. 

 
5. Finally select the range of addresses that the 
polling functions should poll. Valid values range from 
000 to 126.  Make sure the value you select for the 
Range From is lower than the value you select for the 
Range To. 
 

6. Click on the Save Button . 
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Command Buttons 
 
Once you change the settings of the Poll/Delay 
parameters or the Protocol parameters you need to save 
and close. 
 

Click on the Save button  after you make the required 
changes to the settings. 
 

Click on the Close button  to close the window.  This 
button closes the window without warning of any 
unsaved changes.  So make sure you save before you 
exit. 

 



  

 
E-swipe User's Guide                                                                                 26 



  

 
E-swipe User's Guide                                                                                 27 

CHAPTER 4 – The 
Communication Port 

  
This chapters describes in details the process of changing 
the port parameters, opening and closing the port. 

 

Port Parameters 
 
This command allows you to select the communication 
port settings that E-swipe should use when 
communicating with the reader. 
 
To access the Port Parameters command, select Setup 
⇒ Port Parameters. 
 

 
 
Then change the following parameters if necessary. 

 
Port 
 
Select the port that the reader will be connected to. You 
can choose from COM1 to COM16. 
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Baud Rate 
 
Select the baud rate. The selectable range is 300 to 
256000. 
 

Data Bit  
 
Select 5, 6, 7 or 8. 
 

Parity  
 
Select even, odd, none, mark or space. 
 

Stop Bits  
 
Select 1, 1.5, or 2. 
 
In protocol mode, the allowable settings for these 
parameters are as follows: Baud Rate between 1200 
and 19200, Data Bits = 8,  Parity = None, Stop Bits = 1. 
 

 If the communication port was open before you 
changed these setting, the changes will not take effect 
until the port is reopened. 
 
This command will only change the port parameters in 
the software.  To change the settings on the reader, use 
the Set Reader Options command or the Send 
Command. 

 

Command Buttons 
 

When you change any of the settings you need to save 
and close the window. 
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Click on the Save button  to save the changes made. 
 

Click on the Close button  to close the window.  This 
button closes the window without warning of any 
unsaved changes.  So make sure you save before you 
exit. 
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Open / Close the port 

 
Eventhough there is no specific command under the 
main menu that opens the port, E-swipe provides 
several ways to open it both automatically and manually. 
 
When you select any of the commands under the 
following menus the port will be opened automatically. 
These menus are: 
 
Download 
Upload 
Reader Commands 
 
The commands under these menus will open the port 
only if it is closed. They will reopen it only if they were 
accessed after changing the settings for the port and 
port parameters. 
 

 Changing the settings under the port parameters will 
not reopen the port. 
 
 
To open the port manually, click on the light  bulb icon of 
the button toolbar.  
 
The light bulb icon also serves as an indicator for the 
status of the port. A green bulb icon indicates that the 
port is open.  A red bulb icon indicates that the port is 
closed. 
 
The  status bar for the main window displays the status 
and settings for the communication port. 
 
Once the port is opened it cannot be automatically 
closed. To close the port, you should click on the light 
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bulb icon of the button bar. The port is closed when you 
exit E-swipe. 
 

 The port will fail to open if it is occupied by another 
hardware such as a mouse. 
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CHAPTER 5 – E-swipe Text 
Editor 

 

Introduction 
 
The E-swipe text editor is a small editor that allows you 
to create and save a text file.  You may want to use this 
feature to create the schedules and employee files that 
need to be downloaded to the reader.  Or you may want 
to use it to view the log or polled data files uploaded 
from the reader. 

 
Opening the Text Editor 

 
To open the text editor, follow the steps below. 
 
1. From E-swipe's main menu, select Terminal Data. 

 
2. Then select E-swipe Text Editor. 
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E-swipe’s Editor’s Main Screen 
 

 

Main Menu 
 
File – contains commands to create, open and save a 
file. 
Edit – contains commands to edit the text in an open file. 
Search – contains commands to search for text in an 
open file. 
Options – contains commands to show or hide the 
editor’s toolbar. 
 

Tool bar 
 
The tool bar has buttons that allows you to access the 
editor’s features quickly. These buttons are: 
 
New File - use to create a new file. 
Open File - use to open an existing file. 
Save File - use to save a new or existing file. 
Copy - use to copy text. 
Cut - use to cut text. 
Paste - use to paste text. 
Find - use to search for text. 
 
The tool bar can be made invisible by selecting Toolbar 
from the Options menu.  When the toolbar is visible a 
check mark will appear next to the Toolbar option. 



  

 
E-swipe User's Guide                                                                                 35 

Working with Files 
 

Create a New File 
 
To create a new text file, follow the steps below. 
 

1. From the E-swipe text editor's main menu select 
File. 
 

2. Then select New or click on the New File button 
of the toolbar. 

 
If you have made changes to an open file, E-swipe 
will ask you if you want to save the changes.  Save 
the file if necessary and continue with the next step. 
 
3. Once created, you can begin typing. 

 

 When you first open E-swipe's text editor, a new file 
will be automatically created for you. 
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Open a File 
 
To open a file in E-swipe text editor, 
 
1. From the File menu, select Open or click on the 
Open File button of the toolbar. 
 
2. In the Look In list box, select the drive and folder 
where the file is. 
 
3. Double-click on the file name, or highlight it and click 
on the Open button. 

 

 The editor cannot open files that are larger than 65K. 



  

 
E-swipe User's Guide                                                                                 37 

Save a File 
 
After you make changes to a file using E-swipe's text 
editor, you may want to save it. 
 
To save a new file, 
 
1. From the File menu, select Save As.  The Save As 
dialog window will appear. 

 

 
 
 

2. In the File name text box, type a name for the file. 
 
3. In the Save As Type list box, select the type of the 
file. 
 
4. In the Save In list box, select the path (drive name 
and folder) where you want the file to be placed.  The 
default is the application path. 
 
5. Then click on the Save button to save the file.  The 
Cancel button on this dialog box cancels the save 
operation. 
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To save the changes to an existing file, 
 
1. From the File menu, select Save.  The file will 
automatically be saved under the path and name that 
appears in the title bar.  If you want to change the name 
or location of the file use the Save As command as 
described above. 
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Close a File 
 
E-swipe cannot upload or download to and from a file if it 
is being used by any application including its text editor. 
 
There are two ways in which an open file in the text 
editor can be closed. 
 
1. By opening another file or by creating a new file. 
 
2. By closing the text editor. 
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Work with Text 
 
E-swipe's text editor allows you to cut, copy, paste and 
search for text.  All these options are located under its 
Edit menu.  But before you use any of them you need to 
select the text.  Under the Edit menu, the Select All 
option allows you to select all the text at once. 
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Cut Text 
 
To cut text, 
 
1. Select the text you want to cut. 
 
2. Select Edit and then select Cut, or click on the Cut 
button in E-swipe text editor's toolbar. 
 
Now you can paste the text you cut anywhere in the 
document. 
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Copy Text 
 
To copy text using E-swipe's text editor, 
 
1. Select the text you want to copy. 
 
2. Select Edit and then select Copy, or click on the 
Copy button in the E-swipe text editor's toolbar. 
 
The copied text can be pasted in another location in the 
document using he paste command. 
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Paste Text 
 
The text should be copied or cut before you can paste it. 
 
To paste text, 
 
1. Place the insertion point where you want to paste 
the text. 
 
2. From the Edit menu, select Paste. 
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Search for Text 
 
From E-swipe's text editor Search menu, you can 
access commands that help you locate specific words or 
characters quickly and easily. 
 
To locate text, 
 
1. In the document, click where you want to start 
searching. 
 
2. From the Search menu select Find.  The Find Text 
window will appear. 

 

 
 

3. In the Find What text box type the text you want the 
text editor to look for. 
 
4. Check the Match Case box if you want to find the 
text that matches the upper and lower case of the text 
you typed. 
 
5. The text editor will start searching the document 
from the insertion point and in the direction you specify 
in the Find dialog box. 
 
6. Click on the Find button. 
 
7. If you want to find additional instance of the same 
text, select Search and then select Find Next. 
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CHAPTER 6 – The Log File 
 

The data received from the reader can be saved in a file using 
the Open Log File command.  Once you open a log file, all the 
data coming from the reader will be saved in it.   
 
In this file all types of data will be saved.  Such as transactional 
data, access control data, responses etc… Whereas, the data 
files that you open when uploading data will only save the 
uploaded or polled data and will be closed automatically when 
the operation ends.  When you open a log file and an upload 
file, you will have two copies of the same data. 
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Open Log File 
 
 
To open a log file, 

 
1. Select Terminal Data. 
 
2. Select Open Log File. 
 
The Open Log File dialog window will appear. 
 

 
 

3. In the Look In list box, select the drive and folder 
where you want the file to be placed. 
 
4. In the File Name text box, type a name for the file.  If 
that name already exists, you will be asked if you want to 
overwrite it. 
 
5. Click on the Open button of the Open Log File 
dialog window. 

 
6. The file will remain open until you close it using the 
Close Log File command under the Terminal Data menu 
or you exit E-swipe. 
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 E-swipe starts saving the data in the log file the 
moment you open it.  However any data received before 
the file was opened will be lost. 
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Close Log File 
 
The Close Log File command is enabled only if a log file 
is open. 
 
As mentioned in the Open Log File topic, the log file is 
closed automatically once the application is closed.  
However, if you want to be able to view the contents of 
this file while E-swipe is running you need to close it. 
 
To close a log file, 
 
1. Select Terminal Data. 
 
2. The select Close Log File. 

 

 Do not close the file until all the data you want to be 
saved in it is received from the reader. 
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CHAPTER 7  Access Control 
List 

 
In order to take advantage of the access control capabilities of 
the SA and STA readers you need to download schedule and 
employee data to them.  Once you download these lists you 
may want to upload and view the data stored on the reader. 
This chapter describes the download and upload process of the 
access control list. 

 
 

 
 

As you can see in the figure above, the Download menu 
contains three commands to download the access control list.  
These commands are described in the following sections. 
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Download Schedules List 
 
The download schedules list allows you to download a 
schedules' file to the reader. 
 
Before you access this utility you should create the 
schedule list and save it in a text file.  You can create the 
list using any text editor or using E-swipe's text editor.  If 
you have the data available try exporting it to an ASCII 
format. 
 
The data contained in the file should be in the following 
format: 
 
sss,hh:mm,hh:mm,d where 

 
 

Field Description 
  
sss a 3-digit schedule# (001-100) 
d the day of the week (Monday=1,..., Sunday = 7)
hh:mm the schedule's start time (e.g. 13:00) 
hh:mm the schedule's end time (e.g. 08:00) 

 

 The time should be in 24-hour format.  For example, 
1 PM should be entered as 13:00.  This file should  not 
contain a header. 
 
To download a schedules' list, 

 
1. Select Download. 
 
2. Select Download Schedules List.   

 
The Open Download Schedules File dialog window will 
appear. 
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3. Select the file you want to download. 
 
4. Click on the Open button.  If you click on the Cancel 
button the download operation will be cancelled. 
 
5. If the protocol is enabled in the software, the Unit 
Address window will appear.   

 

 
 

If you want to download to an address other than the 
default address, enter a new address.  This address can 
be between 0 and 126.  
 
6. The Cancel Send/Receive window will appear to 
allow you to cancel the download operation at anytime. 
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The responses coming from the reader will appear in the 
View window.  

 
 

 
 
 

For more information, consult the IBC SA/STA product 
user's guide on the Add Schedule programming 
command. 
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Download Employees List 
 
The download Employee List utility allows you to 
download a file of employee IDs and schedule numbers 
to the SA and STA reader. 
 
You should download the schedule list to the reader 
before you download the employee list, unless all the 
schedules in the employee list exist in the reader or no 
schedule check is required. 
 
Before you download the file you should create it using 
any text editor, including E-swipe's text editor.  The data 
in the file should be in the following format: 
 
 
sss,iiii....  where 

 
 

Field Description 
sss A 3-digit schedule# (000-100).  Enter 000 if you 

want to allow the employee to clock in and out 
anytime. 

iiii.... The employee ID. 
 
 

To download an employee list, 
 
1. Select Download. 
 
2. Select Employee List with Checking if you want 
the reader to check if the ID exists before adding it, 
 
3. Select Employees List without Checking if you 
want the reader to add the ID without checking if it 
exists. 
 
The Open Download Employee File dialog window will 
appear. 
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4. Select the file you want to download. 
 

5. Click on the Open button to download the file. 
 
6. If the protocol is enabled in the software, the Unit 
Address window will appear.  If you want to download to 
an address other than the default address, enter a new 
address.  This address can be between 0 and 126.  Click 
on the OK button of this window. 

 
7. The Cancel Send/Receive window will appear.  This 
window allows you to cancel the download process at 
any time by clicking the Cancel button. 

 
Responses from the reader will be sent to the View 
window.  The reader returns one of three responses: ID 
is added, ID is not added, or Schedule is invalid. 
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For more information, consult the IBC SA/STA product 
user's guide on the Add Employee into list programming 
command. 
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Upload Access Control List 
 
The Access Control List allows you to upload the control 
list from the reader. Use this command if you want to 
know the list of employee IDs and the schedules stored 
on the reader. 
 
To upload the access control list, follow the steps below: 
 
1. Select Upload from E-swipe 's main menu. 
 
2. Then select Upload Access Control List. 

 
3. The Upload File dialog window will appear.   

 
If you want to save the data in a file, select the folder 
from the Look In list and enter the name of the file in the 
File Name text box. Then click on the Open button.  
 
If you do not want to save the data, click on the Cancel 
button of this window. 
 
4. If the protocol is enabled the Unit Address window 
will appear.  Enter the address (0 - 126) from which you 
want to upload the data. Then click on the OK button. If 
you click on the Cancel button of the Unit Address 
window the upload operation will be cancelled. 
 
5. Next, the Cancel Send/Receive window will appear.  
The Cancel button of this window allows you to cancel 
the upload operation at any moment. 
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The data coming from the reader will be sent to the View 
window.  It will appear as follows:   

 

 
 

iii...,sss  where  
 

Field Description 
iii… The employee ID. 
Sss The schedule#. 
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CHAPTER 8 – Polling Data 
 

 
There are two types of data that can be uploaded from 
the reader.  These two types are: transactional data and 
access control data.   
 
 

 
 
 
Depending on the type and operating mode of the 
reader, you can upload transactional data using the 
following commands that are available under the Upload 
menu: 
 
Poll STA, DC Reader 
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Poll and Purge STA, DC Reader 
Poll SA Reader 
Poll J Reader 
 
The access control list can be uploaded from an SA or 
STA reader using the following command which is also 
available under the Upload menu: 
 
Upload Access Control List  (described in the previous 
chapter). 



  

 
E-swipe User's Guide                                                                                 61 

Poll STA/DC Readers 
 
Readers such as an STA, and DC store the transactional 
data.  From E-swipe you can upload this data as follows: 
 
1. Select Upload from E-swipe's main menu. 
 
2. Select Poll STA/DC Reader if you want to poll the 
data and keep it in the reader.  
 
Select Poll and Purge STA/DC Reader if you want to 
poll the data and then clear the reader's memory.  
 
The Upload Data File dialog window will appear. 
 
3. If you want to save the polled data in a file, enter a 
path and name for it and click on the Open button. 
Otherwise, click on the Cancel button. 
 
4. If the protocol is not enabled, the reader connected 
to the serial port will be polled until an "END" is received.  
 
If the readers are networked, the poll command will poll 
each reader whose address falls in the range of 
addresses set up in E-swipe.  Each address will be 
polled until an "END" is received.  Then the next address 
in the range will be polled and so on.  
 
If you have selected a Poll data file, then all the data 
except for the "END" will be saved in it.  
 
The data received will appear in the View window as 
follows:  
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s,mm/dd/yy,hh:mm:ss,iiii......  where 
 
 

Field Description 
S The status of the transaction 

0 – Access is granted. 
1 – Bad employee ID. 
2 – Employee is not clocking in/out within the 
scheduled time. 

Mm/dd/yy The date. 
Hh:mm:ss The time of clock in / out. 
iii..... The employee id. 

 

 The Poll and Purge STA/DC Reader command polls 
the data from the reader until an “END” is received. It 
then sends the purge command to purge the contents of 
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the transactional data file.  If you cancelled the polling 
process at any time before the “END” is received the 
data on the reader will not be purged. 
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Poll SA Reader 
 
Like the J reader, the SA reader does not store the 
transactional data.  It should be connected to your PC 
during operation, otherwise, the data will be lost.  Unlike 
the J reader, the SA reader stamps the data with a time 
and date. 
 
To poll an STA reader, follow the steps below: 
 
1. Select Upload from E-swipe's main menu. 
 
2. Select Poll SA Reader. 
 
The Upload Data File dialog window will appear. 
 
If you want to save the polled data in a file, enter a path 
and name for it and click on the Open button.  
 
Otherwise, click on the Cancel button. 
 
In protocol as well as in non protocol mode, the data will 
appear in the View window once scanned.   
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This data will appear as follows: 
 
mm/dd/yy hh:mm:ss iii...    Granted 
or  
mm/dd/yy hh:mm:ss iii...    Denied 
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Poll J Reader 
 
Polling a J reader differs from polling an STA  and DC 
readers. Since the reader does not store the data, it 
should be connected to your PC and the polling function 
should be running as long as the employees are 
scanning their ID's. 
 
Precisely, you can poll a J reader as follows: 
 
1. From the E-swipe's main menu, select Upload. 
 
2. Then select Poll J Reader. 
 
3. The Upload Data File dialog window will appear. If 
you want to save the uploaded data in a separate file, 
enter a path and name for it in the File Name text box. 
Then click on the Open button. If you don't want to save 
the data click on the Cancel button.  

 
4. The Cancel Send/Receive window will appear. 

 
5. If the protocol is disabled, the upload command will 
poll the single reader that is connected to the serial port.  
If the readers are networked, the upload command will 
poll each reader in the range one at a time. 

 
The data coming from the reader will not contain a date 
or time. The Poll command adds the system's time and 
date to the data at the time of polling.  The polled data 
will appear in the View window as follows: 
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iii...,mm/dd/yy,hh:mm:ss where 
 

Field  Description 
iii…. The employee ID. 
Mm/dd/yy The system Date at the time 

of scanning. 
Hh:mm:ss The system Time at the time 

of scanning. 
 

 
6. To end the polling process, you should click on the 
Cancel button of the Cancel Send/Receive window. 

 

 The reader will not accept an ID until the previous 
data is polled.  
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CHAPTER 9 – Reader 
Commands 

 
This chapter describes in details the menu commands that 
program the reader.  All of these commands are available 
under the Reader Commands menu.  

 
 

 
 

Commands such as Set Time, Set Reader Options, Set Relay 
Options, Set Speaker Options, Set LEDs Options, Set 
Barcodes Options, and Set Magstripe Options allows the user 
to program the reader by clicking on the button next to the 
commands.  Whereas, the Send Command requires the user to 
enter the programming command and to send it to the reader.  
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Set Serial Options 
 
Use the Set Reader Options to change the serial port 
settings on the reader such as the baud rate, parity and 
data bits. 

 
 

 
 
 

Also, use this command to change the protocol settings 
on the reader. 
 

 
To change the settings on the reader,  
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1. If the protocol is enabled, enter the address of the 
reader in the address text box at the right of the 
command. 

 
2. If the comand has a selection box, select the 
required setting from the list.  For example, the ‘Set 
Baud Rate to’ command has a selection box from which 
you can select the baud rate. 

 
3. Click on the command button at the left of the 
command. 
 
The use of these commands should be done carefully. 
When you change any of these settings on the reader, 
you need to change them in the software as well. 
Otherwise, the software will not be able to communicate 
properly with the reader. 
 
For example,  if you click on the button next to "Set to 8 
bits and no parity. " command you will reset the port 
settings on the reader.  To communicate with the reader 
afterwards,  you should change the data bits to 8 and the 
parity to none in the software. 
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Set Time 

 
After you receive the reader from the factory, you need 
to reset the date and time set in it. 
 
The Set Time command provides an easy way to set the 
date and time on the reader.  
 
To reset the time, follow the steps below: 
 
1. From the Reader Commands menu, select Set 
Time. 

 
2. The Set Time window will appear.  

 
 

 
 

 
If the communication port is not already open, this 
command will open it. When this window appears, the 
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date, time and day of the week boxes will display the 
computer's date and time. 

 
3. If you do not want to set the time on the reader to 
your system's time, change the settings as follows.   

 
The Date should be entered as follows: mm/dd/yy. For 
example, 02/09/99. 
 
The Time should be in 24-hour format (i.e. the valid 
enteries for Hour are 00- 23).  The time should be 
entered as follows: hh:mm:ss.  For example, 13:01:30. 
 
The Day of the Week can be selected from the list.  

 
4. If the reader is networked, enter its address in the 
Unit Address text box. 

 
5. Click on the Send button to reset the reader to the 
date and time that appears in this window. 

 
Responses coming back from the reader will appear in 
the Reader's response text box and they could be one of 
the following: 

 
 

Response Description 
Reader is not 
responding 

No response came back from the reader 

Invalid Time The date or time entered is not valid. 
Time is Set The reader received the command and it set 

the time and date. 
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Set Barcodes Options 
 
All the symbologies that the reader can read can be 
configured using the Set Barcodes Options command. 
  
To access this command, select the Set Barcodes 
Options from the Reader Commands menu.  Once 
selected, a submenu will appear from which you can 
select the symbology you want to configure on the 
reader.  
 
 

 
  
  
Most of the symbologies can be programmed using the 
following commands: 
 
Ø Enable/Disable the symbology. 
 
Ø Enable/Disable the check digit. 
 
Ø Transmit/ don’t transmit the check digit. 
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Ø Set the barcode length. 
 
Ø Enable/ Disable the direction indicator. 
 
Ø Enable/ Disable the extra bars. 
 
Ø Set the barcode prefix. 
 
The figure below shows all the commands you can 
program the Code 39 symbology to. 
 
 

 
 
To program the symbologies follow the steps below,  
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1. If the protocol is enabled, enter the address of the 
reader in the address text box at the right of the 
command. 

 
2. If the comand has a selection box, select the 
required setting from the list.   

 
For example, the ‘Set Barcode Prefix to’ command has a 
selection box from which you can select the prefix 
character you want.  You can enter the character in the 
list box provided or you can select the character from the 
list.  However, there are certain characters that you 
should always select instead of typing. These characters 
are: 
 
None disable the prefix 
Space space character 
Tab tab character 
 
Other commands such as ‘Set Barcode Length to 00’ 
requires you to change the ‘00’ in the command to the 
length you want.  

 
3. Click on the command button at the left of the 
command. 
 
The reader will respond with an ACK (Command 
Acknowledge) or a NAK (Command Not Acknowledge) if 
operating in protocol mode.  This response is displayed 
in the Response text box. 
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Set Magstripes Options 
 
The Set Magstripes Options command allows you to 
program every track that the reader can read.  It is 
available under the Reader Commands menu. Once 
selected, a submenu will appear from which you can 
select to program: Track 1, Track 2, Track 1 & 2. 

 
 

 
 
 

  Programming track1 is equivalent to programming  
track 3 on readers that read track 2 and 3. 
 



  

 
E-swipe User's Guide                                                                                 78 

For each track you can program  the reader  as follows: 
 
Ø Enable or disable track. 
 
Ø Transmit /Don't transmit the LRC character. 
 
Ø Set the magstripe length. 
 
Ø Transmit /Don't transmit stop and start character. 
 
Ø Select the prefix character. 
 
Ø Select the delimiter character. 
 
Ø Transmit /Don't transmit the direction indicator. 
 
Ø For multitrack readers, each track can be 
programmed to: 
 
Ø Use the standard character set for the track, or 
another character set. 
 
Ø Transmit before the other track. 
 
Ø Set intertrack delimiter. 
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The figure above shows all the commands in which you 
can program Track 1. 
 
To program the magstripe tracks follow the steps below,  
 
1. If the protocol is enabled, enter the address of the 
reader in the address text box at the right of the 
command. 

 
2. If the comand has a selection box, select the 
required setting from the list.   

 
For example, the ‘Set Prefix to’ command has a 
selection box from which you can select the prefix 



  

 
E-swipe User's Guide                                                                                 80 

character you want.  You can enter the character in the 
list box provided or you can select the character from the 
list.  However, there are certain characters that you 
should always select instead of typing. These characters 
are: 
 
None disable the prefix 
Space space character 
Tab tab character 
 
Other commands such as ‘Set Magstripe Length to 00’ 
requires you to change the ‘00’ in the command to the 
length you want.  

 
3. Click on the command button at the left of the 
command. 
 
The reader will return one of two responses, 
 
Command Acknowledged – when the command is 
recognized by the reader. 
 
Command Not Acknowledged – when the command is 
not recognized by the reader. 
 
Both responses will appear in the Response text box. 
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 Set LEDs Options 
 
Some readers can have their LEDs programmed to 
function as follows: 
 
When the reader is powered on, 
 

 
 

 
Ø You can program it to have the red LED turned on or 
the red LED turned off. 
 
Ø You can also program it to have the green LED 
turned on or the green LED turned off. 
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And after a good read, 
 

 
 
 
Ø You can program the reader to turn the red LED on 
for xx second or the to turn the red LED off. 
 
Ø You can also program it to turn the green LED on for 
xx second or to turn the green LED off. 
 
The LED Options command is accessible from the 
Reader Commands menu. After you select the Set 
LEDs options command the port will be opened if not 
already opened. 
 
To program the LEDs follow the steps below,  
 
1. If the protocol is enabled, enter the address of the 
reader in the address text box at the right of the 
command. 

 
2. Some commands require replace the ‘00’ value in 
the command to the value you want.  Such as “Red  
Light on for 00 Sec After Good Read”. 
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3. Click on the command button at the left of the 
command. 
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Set Speaker Options 
 
The speaker available on the reader can be 
programmed to beep for a number of seconds after a 
good read or to be turned off after a good read. 
 
You can access this command from the Reader 
Commands menu. There is no need to open the port 
before executing this command because it will opened 
automatically.  
 

 
 
 

To program the speaker to be turned on for a certain 
amount of time after a good read, enter the number of 
seconds desired. Then enter the address if the protocol 
is on. Then click on the button next to this command. 
 
To disable the beeper after a good read, enter the 
address of the reader if networked and then click on the 
button next to this command. 
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Set Relay Options 
 
The Set Relay Options command is available under the 
Reader Commands menu.  If the reader has a relay, you 
may want to program it as follows: 
 
After a good read, 
 
 

 
 
  
Ø Turn on the relay for xx seconds. 
 
Ø Turn the relay off. 
 
Like all the reader commands, the Set Relay Options 
command opens the communication port automatically. 
 
To program the relay you need to click on the button 
next to each command. But before you click on the 
button, if the reader is networked, enter its address in 
the text box provided for the address.  Also, enter the 
number of seconds required if you are programming it to 
be turned on for a certain amount of time. 
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Send Command 
 
The IBC reader can be easily programmed through any 
of the options available under the Reader Commands 
menu. For example, the Set Speaker Options command 
sends messages to the reader to program the speaker. 
 
However, these options do not cover all of the 
programming commands. Any other command can be 
typed in the Send Command window and sent to the 
reader.  In other words, the Send Command allows you 
to program the reader by sending the appropriate 
command. 
 
To send a command to the reader follow the steps 
below: 
 
1. Select Reader Commands then select Send 
command. 
 
The Send Command window will appear, as show in the 
figure below. 
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2. Type the command in the text box provided.   
 
3. Enter the address to send the command to if the 
reader is networked. 
 
4. Check the serial command option if the command is 
a serial programming command. All the commands in 
the J series user's guide are serial programming 
commands (except the serial control commands) 
 
5. Click on the Send button. 
 
The Send command will automatically add the command 
prefix and terminating characters. The responses 
coming back from the reader (if any) are sent to the 
Reader’s Response box. Responses will appear in the 
format that they are received. However, the software 
eliminates the ACK, NAK, ETX and STX characters from 
the string of data received when the protocol is enabled.  
 
If the reader is set to protocol mode, a response of ACK 
will appear as "Command Acknowledged" and of NAK 
will appear as "Command Not Acknowledged".  
 
Command Buttons 
 

The Clear button  erases the contents of the send 
and receive boxes. 
 

The Send button  sends the command to the reader. 
 

The Close button  simply closes the Send Command 
window. 
 
 
For further information on the reader commands, consult 
the IBC User's Guides. 
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APPENDIX I – E-swipe 
Messages 

 
While working with E-swipe you will receive different 
messages.  Some messages will inform you about the status 
of a certain operation.  This kind of messages are explained 
throughout the manual.  This appendix explains in details the 
warning and error messages received.  

 

E-swipe Messages 
 
"Command Acknowledged", "Command Not 
Acknowledged" 
 
The above messages are displayed by the software in 
the response box when an ACK or a NAK is received 
from the reader.  When the command is acknowledged 
by the reader it means that the reader received the 
command and recognized it as a valid command.  It 
does not mean however that the reader is programmed 
according to the command.  When the command is not 
acknowledged by the reader it means that the reader 
received the command but did not recognize it. 
 
“Invalid character.” 
 
This message is received when you enter an invalid 
character (such as typing a space instead of selecting 
‘Space’ from the list) in the Set Prefix or Delimiter 
commands of the Set Barcodes Options and the Set 
Magstripes Options windows. 
 
“Invalid address.” 
 
Upload and download commands accept address that 
range between 0 and 126.  The Reader Commands 
accept address that range from 0 to 127. This message 
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is received when you enter invalid characters ( e.g. 
alphabets) or address that fall off the range. 
 
 

 
 
Files that are opened by another application or by E-
swipe cannot be opened with the text editor.  For 
example, if you opened a log file to save the data in, you 
cannot reopen the file using the text editor. 
 
“Operation valid only when the port is opened” 
 
If the communication port failed to open, you will receive 
this message when you try to send or receive data to 
and from the reader. 
 
“Reader is not responding!”, “NO RESPONSE” 
 
This message is received when the reader does not 
send any response back when E-swipe is expecting one.  
The reader will not send a response if: 
 
Ø the port is not opened or an invalid port number is 
selected. 

 
Ø the reader is not connected to the selected port. 

 
Ø the settings in the software do not match the settings 
on the reader.  For example, the protocol in the software 
is enabled and on the reader is disabled. 

 
Ø the address selected does not match the address on 
the reader. 

 
Ø the reader did not recognize the command.  For 
example, polling an STA reader with the Poll J 
command. 
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“Reader is not responding! Make sure it is set to 
 

 
When the protocol is enabled in the software, a 
response is expected from the reader for every 
command sent.  If no response is received, E-swipe 
displays this message.  You need to either enable the 
protocol in the reader or disable it in the software. 
 
“The file is too large to open.” 
 
E-swipe’s text editor can only open files that are < 65 K 
in size. 
 
"Unable to open the communication port!" 
 
This message is received when the selected port is 
occupied by another hardware or the port is already 
opened by this hardware and cannot be reopened. 
 
“Unable to purge data at address xxx” 
 
E-swipe failed to send the command that purges the 
contents of the transational data file on the reader.  This 
would be due to communication problems. 
 
“Unable to send command.” 
 
This message is received when the software is trying to 
communicate with the reader by sending a command 
while the port is not open or a communication problem 
occurred. 
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APPENDIX II – Getting Help on E-
swipe 

 

Resources 
 
A variety of resources are available to help you use E-
swipe.  These resources are: 
 
On-line help 
 
E-swipe has a comprehensive on-line help system which 
allows you to locate information quickly and easily.  On-
line help can be accessed from the Start menu.  You can 
also access it while you are working with E-swipe, by 
selecting Help from the main menu. 
 
User documentation 
 
This manual contains detailed information on how to use 
E-swipe. For commands and questions related to the 
hardware, you should consult the manufacture’s User’s 
Guide that comes with the software when you purchase 
it. 
 
For additional information and answers to frequently 
asked questions please visit our world wide web as 
described in the next section. 
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Customer Support 

 
If you have a question, a comment or a suggestion 
Escan Technologies Corp. welcomes your inputs 
regarding improvements to E-swipe and/or this manual.  
These comments can be mailed to Escan Technologies 
Corp., or sent electronically via e-mail or via  our World 
Wide Web (WWW) site.  If you have a bug report that 
requires immediate attention, please contact us as soon 
as possible. 
 
If you would like to purchase any of the hardware 
described in this manual, you may contact us for the 
current price and availability. 
 
In order to be eligible for technical support, you must 
register your version of E-swipe with Escan 
Technologies Corp.  In addition to technical support, you 
will receive updates as to what is new in the upcoming 
versions of E-swipe. 
 
When reporting a problem, please include the following 
information: 
 
q Company 
q Mailing Address  
q Phone Number 
q Your Name/Contact Person 
q E-mail Address (if available) 
q E-swipe  Serial Number 
q Date of Purchase 
q Version of Windows 
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Where to send your registration/correspondence: 
 
Email Address:   techsupport@e-
scan.com 

(Putting “E-swipe ” in 
the subject header will 
ensure a quick 
response.) 

 
Telephone:   (909) 270-0043  

(9:00 am - 4:00 PM 
PST) 

 
Fax:    (909) 270-0920  

(24 hours - 7 days a 
week) 

 
Standard Mailing Address:  Escan Technologies 
Corp. 

12140 Severn Way 
Riverside, CA 92503 

 
 
As an alternative to mailing your registration, you may 
contact our WWW site.  In addition to online registration, 
you will find an area to post comments or suggestions, 
look at what is upcoming for E-swipe and related 
software, and download up-to-date files.  Our WWW site 
is at the following addresses:   
 
http://www.e-scan.com 
http://www.exeba.com 
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Notes… 


